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Automatic four-channel open-type system for 
monitoring CO2 exchange and transpiration of leaves  
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Before Initial Use 
It is extremely important that you take the time to review this operator’s manual prior 
to installation and operation of the PTM-48M Photosynthesis Monitor. Otherwise, 
damage may be caused which is not covered under our normal warranty policy. 

Before powering-up the PTM-48M Photosynthesis Monitor, check and, if necessary, 
adjust the power supply to available supply-line voltage. Switching diagram is located 
on the internal side of the power supply’s lid.  

System Composition and Accessories 
 

TYPICAL SYSTEM 
COMPOSITION 

1 x System console 
4 x LC-4A Leaf chambers with holders 
8 x 6m PVC hose 
2 x one-meter stainless steel tripods for holding leaf 
chambers and optional phytomonitoring sensors 
Optional sensors 

 

 

 

SYSTEM CONSOLE LC-4B LEAF CHAMBERS 
 
ACCESSORIES 

HOLDER FOR LEAF 
CHAMBER (4 pcs) 

 

 
 

 

PVC HOSE (2 x 6 x 4 m) 

 
 

CABLE FOR PC 

 

SOFTWARE SETUP CD 

 
 

CO2 ABSORBER 

 
 

SPARE AIR FILTER 

 
 

STAINLESS STEEL TRIPOD 
(1 m height, 2 pcs) 
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SYSTEM CONSOLE 

 

 

LC-4B LEAF CHAMBER 
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Principles of Operation 
 
The PTM-48M Photosynthesis Monitor is a four-channel automated system for 
monitoring CO2 exchange and transpiration of leaves. The system is equipped with a 
set of four original self-clamping leaf chambers, which operate one-by-one in such a 
manner that one of leaf chambers is closed at a time while the others remain open.  
The automatic self-clamping design 
enables keeping a leaf open for more 
than 90% of the time. Thus, the leaf 
environment is not disrupted 
considerably. 

In the open photosynthesis system, 
the CO2 exchange is determined on 
the basis of the depression of CO2 
concentration at the outlet (Cout) of 
the leaf chamber in comparison with 
the incoming ambient air (Cin). The 
CO2 exchange rate is calculated as 
follows: 

E = k×(Cin –Cout)×F, 

where F is the air flow rate and k is a 
dimension factor, which depends on air temperature and pressure and is calculated by 
the system automatically. 

Transpiration rate is determined in much the same way as 

 Tr = (Hout – Hin) x F, 

where   H is absolute concentration of water vapor in the air. To shorten the 
measurement cycle, the Hout is computed during transient period between 20th and 
30th second after closing the chamber. The calculation algorithm also takes into 
account the rising humidity inside the chamber and, hence, allows determining the 
initial transpiration rate at the ambient air humidity. 

The measurement sequence with two leaf chambers is illustrated below:  
 

 
AIR PURGE 

REFERENCE 
CHAMBER 1 

OPEN CHAMBER 2 

 
STAGE 

MEASUR-
EMENT 

CHAMBER1 

CHAMBER 1 

CALCULATION OF 
AVERAGES AND 

RECORDING 

OPEN OPEN 

REFERENCE 
CHAMBER 2 

CLOSED 

 
 
 

TIME SCALE 

 
 
 
 

120 sec 

 
 

Until steady-state 
concentration. 

Upper limit: 60 sec 

 
 
 
 

30 sec 

 
 

Until steady-state 
concentration. 
Upper limit: 60 

sec 

 
 
 
 

30 sec 

MEASUR-
EMENT 

CHAMBER2 

 
PAUSE 

OPEN 

OPEN 

 
 
 
 

Until the next measurement cycle 

SENSORS MESUREMENT 

CLOSED 

The cycle starts from the purging the system that continuous 120 seconds. All 
chambers are open and purged at this stage. Then, during the reference stage, only 
the chamber No. 1 is connected to the measuring system. This stage continues until 
the steady-state concentration has been reached. In any case the reference stage 
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stops after 60 seconds and the chamber No. 1 closes. At the end of 30-second 
measurement stage the records for Chamber # 1 are ready. Then, the second 
chamber repeats both reference and measurement cycles. If optional sensors are 
connected to the system, their readings are collected during operation of all leaf 
chambers. At the end of the measurement cycle, the average values are recorded.  

The typical duration of operational cycle with 4 leaf chambers is about 6 minutes while 
each chamber is closed only 30 seconds. Typical (recommended) time interval 
between cycles is 30 minutes.  

Pneumatic Diagram of the PTM-48M Monitor 

 
The leaf chamber channel is drawn in green and the pneumatic control channel is 
drawn in blue. All controls are described in the Location of Controls section. 
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Installation Directions 

Positioning 

System console 
After the system console has been placed in the desired 
location, level it by means of the adjustable front feet. 
Warning: if the system console is not perfectly leveled, it will 
be unstable, noisy and may lead to malfunctions and broken 
parts. 

Leaf chamber 
Mount a leaf chamber on a tripod as shown below: 
 

1 2 3 4 
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Position of a leaf chamber flaps in operation is shown below: 

OPEN CLOSED 
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Pneumatic Connection 
Connect the desired number of leaf chambers (1 to 4) to air sampling and control 
inlets using twin PVC hoses. Follow the instructions below. 
 

 
 

 
 
 
Choose an inlet for connection. All air-sampling and 
control inlets are located at the right side of the system 
console. Sampling inlets are green and control ones are 
blue. To avoid mismatching, both sampling and control 
PVC hoses are marked with the appropriate color.  

 
 

Unscrew the ring nut. 

Put the end of PVC hose through the ring nut. 

Connect the hose to the air-sampling inlet and tighten 
the ring nut.  

Connect a control end of the hose to the appropriate 
control inlet. 

 

Locate an opposite end of the hose for connecting to leaf 
chamber. 

Put the ends of PVC hose through the ring nuts 

Connect sampling (Analyzer) and control hoses to the 
appropriate inlets of the leaf chamber. 

Tighten the ring nuts. 

 

Electrical Connection 
The PTM-48M Photosynthesis Monitor should be connected to the electrical grounded 
outlet. Make sure that the supply-line voltage matches the working voltage indicated 
on the power supply front panel. 
If necessary, adjust the power supply to available supply-line voltage. Switching 
diagram is located on the internal side of the power supply’s lid.  
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Location of Controls 

Control panel 
Most of manual controls are located at the Control panel. Control buttons and 
appropriate LED indicators are shown in the picture below. 
 

 
 
IMPORTANT NOTE:  All control buttons (except for the Mode switch) are active in the 
manual mode only.  

Remote Control panel 
The Control panel is duplicated in the Terminal emulator 
interface. You can use the same on-screen control 
buttons by clicking the left mouse button on any of them. 
The light indicators are also duplicated on screen. 

 

Air flow control 

 

There is only one Rotameter equipped with the air flow 
regulator, located on the front panel of the System console. 
The normal range of air flow rate is between 0.8 and 1 LPM. 
Adjust if necessary.  
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Preparation for Use 
 

Software Setup 
1. Insert the installation CD into CD-ROM drive in your computer. The software 

installation Setup wizard starts.  

2. Follow the on-screen instructions. 

The default location of the program is following: 

C:\Program Files\Phytech\PTM-48M Photosynthesis Monitor 

The executable file is phsmon.exe 
 

Operation Modes 

Manual Mode 
Manual mode is used only for testing and tuning the system. In manual mode, the 
system may be controlled either by Control panel, located at the front panel of the 
System console, or by its duplication in the Terminal emulator screen. Location of 
controls and indicators are the same. See also page 9.  

Automatic Mode 
This is the main mode of operation. In automatic mode, the system operates 
according to settings specified in the current Project descriptor (see Page 13). The 
data logging session can be initialized only via computer interface (Terminal 
emulator). Then, the system operates automatically and does not require permanent 
connection to the computer. After occasional power interruption, the system continues 
operation in previous mode.   

Optional Sensors 
 
The PTM-48 Photosynthesis Monitor has 11 inputs for optional sensors. The following 
excitation voltages are available: + 15 Vdc, -15 Vdc, +5 Vdc. The maximal current 
load is 0.3 A. Input: 0 to 2.5 Vdc. 

The following phytomonitoring sensors are recommended for use1: 

• PIR-1 Photosynthesis Radiation Sensor;  
• TIR-4 Total Irradiance Sensor; 
• ATH-2 Air Temperature and Humidity Sensor; 
• SMS-2 Soil Moisture Sensor; 
• LT-2M Leaf Temperature Sensor; 
• SF-4M, SF-5M Sap Flow Relative Rate Sensors; 
• SD-5M or SD-6 Stem Microvariation Sensors; 
• DE-1M Electronic Point Dendrometer; 

                                            
1 Commercially available worldwide from Phytech Ltd. and authorized dealers. Refer to 
www.phytech.com  for further information. 



 11 

• FI-LM, FI-MM, FI-SM and FI-XSM Fruit Growth Sensors; 
• SA-2 or SA-20 Stem Auxanometers. 

Connection 

  
Run sensors’ cables through the cable 
glands located at the left side of the 
system console upper box. Open the 
box’s door before and remove left front 
panel.  

Connect sensors according to their 
connection diagram. Use inputs 1-8. Note 
down an input number, used for each 
sensor. 

 

Entering calibration data 
At first, every sensor, which is assigned for use in the PTM-48M Photosynthesis 
Monitor, is to be included into the sensors database. To do this, run the program 
(phsmon.exe file, see also Software Setup section on Page 10.). Then, follow the 
instructions below:  
 
1. In the Project menu, select Sensors database 

 
2. Click New button. 
3. Type in the sensors’s ID – its type and a serial number (SD-5M #2347, for 

instance. 
4. Enter the sensor’s type (SD-5M, for instance). 
5. Specify measurement units (mm, for instance). 
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6. Select data decimal format (#.###, for instance) 
7. Type in the sensor’s description (Stem diameter, for instance) 
8. In necessary, enter the next inspection date for the sensor (04/12/03, for instance) 

9. Click Add button for entering the 
calibration data to the database.  

10. Enter the first approximation point 
specified in the sensor’s calibration 
table (0.000 and and 5.000, for 
instance) 

11. Click OK and continue to enter 
approximation points. 

12. Click Save when finished. The new 
sensor ID appears in the Sensors 
list. 

 

 

Functioning 

Data logging 

Communication with PC 
PM-48M Photosynthesis Monitor has two communication ports:  

RS 232 RS 485 

 
 

Use a 1.5 m communication 
cable enclosed in the system 
accessories. Connect it to the 
available serial COM port in your 
PC. 

Requires a standard RS485/RS232 converter at 
the PC side. Allows to arrange communication at 
the distance up to 1200 m. 

 
IMPORTANT NOTE: Do not forget to specify the used COM port number in the PTM-
48M-Link Setup menu. 
 
The following commands are available for communication in the Terminal Emulator 
interface:  
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Connect  

to make connection between PTM-48M 
Photosynthesis Monitor and a PC.  
Disconnect  

to break connection between PTM-48M 
Photosynthesis Monitor and a PC.  
Download data records  

to download the collected data to a PC.  
Synchronize time  

synchronization of system time with PC.  
Link setup  

to select a COM port for connection. 
 
 
 

Opening and closing a measurement session 

The PM-48M Photosynthesis Monitor logs data in a named data file created by a user. 
A separate measurement session and an associated data file are determined under 
the common Project name.  
To create a new project, follow these steps:  

1. In the menu, select the Project | 
Open/New option. You will see a list 
of Projects.  

2. Click New button and enter a desired 
name of the new Project. By default, 
the program offers the name 
composed as a start date and time: 
YYYYMMDD_TIME. For instance, 
20040716_1418 means that Project 
starts at 14:18, July 16, 2004. You 
may type in another name of the 
project as well.  

 

3. Click OK.  

4. In Project descriptor window, select required options and setting.  
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At first, select the Active chambers channels and chambers types.  

5. Enter the required Timing values of the measurement cycle.  

Measurement time interval  

Includes exhaust time, reference time, exposition time and pause.  
By default: 30 min.  

Exact measurement time  

In case of selected Exact measurement time checkbox, the system starts measurement 
cycles in round points of time. For instance, if you initiate the system at 9:37 and the 
Measurement time interval is 30 minutes, the system starts at 10:00, then 10:30, 11:00, 
11:30, etc. If the checkbox is blank, the system starts immediately, and measurement time 
will be 9:37, 10:07, etc. It is recommended to select this checkbox.  
By default: on.  

6. Extra options  

Overwrite oldest records  

The Overwrite oldest records if memory is full checkbox determines the behavior of the 
system in case of memory overflow. The maximal number of readings, which can be stored 
in the system memory, is 240. If the cycle time is 30 minutes, the memory will be filled up 
during 120 hours or 5 days. Please note that it may happen only if you never downloaded 
the data from the system to your PC during this period. After each data downloading, the 
memory is cleaned and it can accumulate another 240 readings.  

If you select this checkbox, the system will continue data logging even with full memory. 
The new data replace the oldest ones.  

In case of blank checkbox, the system stops data logging when memory is full and 
switches to Pause mode. In this case, the general alarm indicator lights up. This mode is 
recommended because of common assumption that absence of data downloading 
sessions associates with unforeseen lack of maintenance and, therefore, it is better to stop 
the system operation and to save the data.  



 15 

7. Enter the connected optional sensors in the Extra sensors panel. Select an input and choose 
appropriate sensor from the list.  

8. Select temperature [t] and relative humidity [RH] sensors for the calculating VPD and Tr corr.  

9. Click OK, when finished.  

10. If PC is not connected to PTM-48M software will offer to connect.  

To close the current project in your PC, select Project-Close option in the menu. However, all 
information about the project is still saved in the system memory. In order to stop the project 
completely and to clean the system memory, click Stop button or select Project-Stop option. 
The system must be on-line when executes this command.  

 

Project | Open / New | Open  

opens Project descriptor of the project selected in the Projects window. A project may be 
deleted, if necessary, by clicking Delete.  

Project | Modify  

allows making changes in project configuration.  

Project | Stop  

stops measurement session of the project.  

Project | Close  

closes data file, associated with the selected project.  

Project | Recalculate  

allows recalculating the recorded data in case of modification of sensors calibration data.  

Project | Export  

creates a data file with *.txt or *.csv format, for importing to Excel or other data processing 
software.  

All data exports all the data;  

Valid data excepts data marked by asterisk (conditionally rejected)  

On-screen indications 
 
Control panel 

Control panel represents the pneumatic diagram of the system. 
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It contains the following LED indicators and control buttons: 

Automatic Mode  

the system operates in automatic mode. Manual 
controls are disabled.  

Manual Mode  

the system operates in manual mode. All 
manual controls are enabled. Data logging is 
stopped.  

Alarm  

emergency stop in Automatic Mode.  

Channel 1 ... Channel 4  

active air sampling channel.  

Pump  

pump on/off indicator.  

REF (Reference)  

reference values are measured (Leaf Chamber 
is open).  

LC (Leaf Chamber)  

leaf values are measured (Leaf Chamber is closed).  

Air Flow Meter Alarm  

the readings of the Airflow Meter are out of the normal range.  

CO2 Analyzer Alarm  

error message, generated by the CO2 Analyzer.  

Buttons: 

Mode  

Manual / Automatic mode switch.  

Channel 1 ... Channel 4  

channel switch.  

Pump  

pump on/off switch.  

LC / REF (Leaf Chamber / Reference)  

data source selection.  
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The Operation mode table is located at the right lower corner of the screen. It includes the 
following rows:  

CURRENT TIME  

PTM-48M ON LINE/OFF LINE  
connection status between the system and a PC.  

GA STATUS  
status messages, generated by CO2 Analyzer: INITIALIZATION, WARMING, ZERO, etc.  

MODE  
MANUAL/AUTO  

CYCLE PHASE  
EXHAUST, REF1, LC1, REF2, ... LC4, PAUSE.  

RECORDING STATE  
ON/OFF, alarm cause: MEMORY FULL, etc.  
The upper table can be selected from two available: CURRENT MEASUREMENT or LAST DATA 
RECORD. Select a required table in View menu.  

 

CURRENT MEASUREMENT  

represents current readouts of all measuring channels. Updated every second. 
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LAST DATA RECORD  

represents the last record in the database.  

 

In Pause mode (Pump off) there are no records in the table which are related to air analysis 
(concentration, airflow, pressure).  

Select DATA TABLE in View menu to open the data file for viewing.  

 

Viewing data file 
Each column contains data corresponding to a specific characteristic or parameter. Each row contains 
readings corresponding to a time of a record.  

Every row includes:  

• Time of data filing (recording) - cycle start time.  

• C(Ref#) - Reference CO2 concentration (Leaf Chamber is open) - channel #.  

• C(LC#) - Leaf Chamber CO2 concentration (Leaf Chamber is closed) - channel #.  

• F(LC#) - Airflow rate in Leaf Chamber - channel #  

• CO2 Exch# - CO2 exchange rate - channel #  

• H(Ref#) - Reference absolute humidity (Leaf Chamber is open) - channel #.  

• Tr(#) - Transpiration - channel #  

• S# - Readings of extra sensors  

• Atmospheric Pressure  

The following additional calculating values are present if temperature and relative humidity sensors are 
selected in the current Project: 

• VPD - Vapour Pressure Deficit.  

• Tr corr(#) - Calculated transpiration value at the assumption, that humidity of air in the 
chamber is equal to humidity of air outside of the chamber.  

There are three modes of data table view:  
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Full  

includes the following columns:  

• Time of data filing (recording)  
• C(Ref#) - Reference CO2 concentration (Leaf Chamber is open) - channel #.  
• C(LC#) - Leaf Chamber CO2 concentration (Leaf Chamber is closed) - channel #.  
• F(LC#) - Airflow rate in Leaf Chamber - channel #  
• CO2 Exch# - CO2 exchange rate - channel #  
• H(Ref#) - Reference absolute humidity (Leaf Chamber is open) - channel #.  
• Tr(#) - Transpiration - channel #  
• S# - Readings of extra sensors  

Brief  

includes the following columns:  

• Time of data filing (recording)  
• C(Ref1) - Reference CO2 concentration (Leaf Chamber is open) - channel 1.  
• CO2 Exch# - CO2 exchange rate - channel #  
• H(Ref#) - Reference absolute humidity (Leaf Chamber is 

open) - channel #.  
• Tr(#) - Transpiration - channel #  
• S# - Readings of extra sensors  

Custom  

includes columns selected by a user in Define columns for custom 
view (View | Table view mode menu)  

Some of the data may be marked by asterisk. Those values are rejected 
because there was no steady-state reading of CO2 Analyzer or Humidity 
sensor at the moment of measurement or extra sensor reading is out of 
bounds.  
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Export data file for further processing 

 

1. Open the data file view (View-Data table) 

2. Select Project-Export submenu. Choose between two 
options: 

�� To export all data in the data file; 

�� To export the valid data only. The records with 
asterisk (see above) will be excluded. 

3. Choose the file format. Two formats are available:  
*.txt and *.csv. Name and save the file. 

 

Terminal Emulator 
To learn more about the Terminal Emulator read the help file associated with the 
program.  
 

Specifications  
 
�

� � �� � � �� 	�
� � 	�� 
 � �� � � ��� � � ����� �

� � � 	�� 
 � �� � � �� � � � ���� �� ���

� � � 	�� 
 � �� � � ��� � � ��� � � � �� ��� � 

� �� � � � � � � ��� � ��� 

� �� � � � �

�� �� �� � � � � � ��� � ��� ������� � � � �� �� �� �� � ��

�  ���� � �� � � �� � ��� � �� � �� 
� ��� � � !� ��� � ���" � ��� 	� � � � � �� � � 
� # � � ��$ % & !� ��' ' $ � ��� ����( $ & ��

�  ��� � � � � � �� � ��� � ��� � �� � � �� � ��� � � ) � ��� !*� � � �� � ��

$ �) � � 
�� � ��� ����� � ��� + !� + �, �- . � �� � ���� ��
 ���) � � 
�� " � � � ) �� ) ��

��� ��� � �� � � �� � ��� � �� � �� 
� ���� �� ) � � �� � �� �� ��� �� � � � �� � � �� � � �
 � ��� ��� ��� � �� � ��$ �/ 0 . ��$ � � ��� �� � �
& 1 ��$ � ��# � � 
� � � ���

& �� ��� �� � � � �� � � ��� � �� � � �� � ��� � � ) � ��� ��� �. � �2 � �

3 � � � � �� � �
��� ��4 �� 5*�2� �

& �� �� � 
� ��" � �
 � ��� ��� ��� � �� � � �� � ��� � � ) � ���� ��� *� � �6 �3 ��

3 � � � � �� � �
��� ��4 �� 5*�6 �3 ��

& �� �	
� � ��� � �� � � �� � ��� � � ) � ��� 5*��� �*5� �� ' 7 �

� & � � � � � � � ��4 �� 5� ��� ' 7 �

� � ��� 
�� � � ) � �� 	�� �� 	
� � �� � �� ��� ��
 � �� �� ��� � �� � � �� � ��� 
 � � � � 
��� 58 ��� �*5� �� ' 7 �

3 � �� � ��� � �� � � �� � ��� � � ) � �� 	��  ��� 9 � 
 � � ) � ��!�� ��� ��� ��: �� 
�  ��!��!*�

3 � �� � ��� � �� � � �� � ��� � � ) � �� 	���� �� 9 � 
 � � ) � ��� ��� �. � ��) ��� �����!*�

� � �� � � �� 	��� � � ���	� � �� � ��� � � 
��� � �� ����**�

;� � � ��� � � ) � ��� ��� ���< � � �



 21 

$ � �� 
�� ) �� � �� ���*. ��- � ��� � �= � ���� ���� 
� � �� � 
� ��

> � � � ��� � �� 	�� � ��" � ��� � �� � � �� � ��� � � 
� ��� 
 � � �
� � 	�� 
 � �� � � ����� 
� �� � ���- � ����

' � � � � ��� � � 
� �	� � �� � ��� � � 
��� � �� ����? *. �< � � ��!*. �< � � ��� � � �? . �< � � �, � 5- & �

' � � � � �� � @ � �� � �� � ������� A**� A*� � �< & � B�. � A= � ��# , *. � C 5��

;� �� � 	� � � ��3 $ �- ��� � � �3 $ � 8 . ��� � ��� � � 
�5�

/ � ���� � 
�D �� 
� �� � ��� 	�� � � � �	� � �C �� � � � ��E 8 ��� � � �7 D �� � � �F ' 5�����

 
Specifications are subject to change without notice 

Maintenance 

Objects of routine inspection 
1. Airflow rate in sampling channel.  Adjust if required.  
2. Color of the absorber in the absorber column. This absorber should be 

replaced when it is two-thirds exhausted (brown). 
3. Air filters clogging. Replace filter when required. 
4. Transparency of leaf chamber windows. Clean when required by soft brush or 

tissue. 
Failure to comply with these instructions may result in system malfunction.  
The inspection points are marked on the Control panel and labeled on the System 
console and leaf chambers.  
 

C02 Absorber and Air Filter 

 

Both Air filter and CO2 Absorber column  
are located at the front side of the 
System console (see Page 3). 
For CO2 Absorber column: 

1. Check the color of the absorber. 
2. If about two-thirds are brown, go to the 

next step. 
3. Switch the pump off. 
4. Remove the clamp. 
5. Pull out the tube 
6. Replace absorber medium according to 

the instruction below and then put the 
column back. 

For Air filter: 
     Replace the Air filter when required to avoid 
clogging. 

  
 
The following Section is quoted from theSBA-4 Operator’s Manual 
(Version 1.0, ©2000 PPSystems, UK) 
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Absorber Column 
We recommend monthly inspections of the absorber column foam pads, filter disks and “O” rings. Also 
check for cracks on the clear plastic column itself. The absorber column is fitted with 2 black end caps 
containing 2 white plastic disks, 2 “O” rings and 2 foam pads at each end. The black end fitting(s) can 
then be removed and the contents emptied when required. Columns are fitted with foam pads at each 
end to stop the contents spilling out if the ends are inadvertently pulled off during removal. When 
replacing the contents, the columns should be tapped to ensure tight packing and the foam replaced as 
found. The "O" rings on the end fittings should be occasionally lightly smeared with silicone grease to 
aid ease of fitting. 
Take care when replacing the end fittings as the "O" rings can roll up and out of the groove. 
This will give rise to leaks and the SBA-4 will not work properly. 
There can be a very tight fit between the tubes and end fittings. Pushing the end fittings on 
without proper care can cause the absorber column to crack. Again this will allow air to leak in 
and out of the column. 
It is sensible to examine the absorber column each time the contents are replaced as any leakage of 
ambient air into the gas circuit generally causes errors during “Autozero” operation or fluctuating 
reference CO2 concentration during measurement. 
There are three items that should be checked after re-filling a column: 
 
Absorber Column Foam Pads 
The foam pads become worn over time and should be inspected regularly and replaced when torn or 
reduced in size. The foam must be open cell type, such as packing foam. 
 
Absorber Column Filters 
Each absorber column black end cap contains a white plastic filter disk. Generally these do not need to 
be replaced. However, they must be present to prevent any of the column contents being drawn with 
the 
gas stream into the instrument. 
 
Absorber Column “O” Rings. 
The “O” Rings on the end caps of the columns should be very lightly smeared with silicone grease to 
aid 
ease of fitting and improve the seal. Once sealed, end fittings should be checked to ensure that the O-
rings 
are seated correctly in their groove and that they are not trapped or pinched. 
There is also a small “O” ring on each of the absorber end cap fittings. These should be in good 
condition. Replacement “O” ring and filter sets can be ordered from PP Systems if required. See figure 
below for location of “O” rings and foam pads. The white plastic filter disks are located on the black end 
caps inside the absorber column. 
 
Soda Lime 
Soda Lime is supplied as self-indicating granules (1-2.5mm) which turn from green to brown as it 
becomes exhausted. This desiccant should be replaced when it is two-thirds exhausted (brown). Soda 
Lime cannot be regenerated and should be discarded when exhausted. Frequent replacement should 
not be required under normal circumstances. The amount of change is highly dependent on the “Auto-
Zero” frequency and flow rate. Under normal operating conditions, this desiccant is changed 
approximately 1 time per month. 
For accurate measurements and calibration, it is absolutely critical that the SBA-4 absorber column is 
not exhausted. If the soda lime is becoming exhausted, it will cause the ZERO to be performed on non-
ZERO air causing an error in the calibration. 

! CAUTION ! 
WASH YOUR HANDS AFTER HANDLING SODA LIME 

MATERIAL SAFETY DATA FOR SODA LIME 
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Contact Information on CO2 Absorber 
PP Systems PP Systems 
241 Winter Street Unit 2, Glovers Court, Bury Mead Road 
Haverhill, MA 01830 U.S.A. Hitchin, Hertfordshire, SG5 1RT, U.K. 
Tel: +1 978.374.1064 Tel: +44 (0) 1462.453411 
Fax: +1 978.374.0972 Fax: +44 (0) 1462.431090 
Email: support@ppsystems.com 
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Leaf Chamber Filter 

 
 

 
 

1. Check visually the state of the net filter. In 
case of clogging (dust, particles), go to the 
next step 

2. Open a screw-top 

3. Take out the net and remove foreign 
particles. Wash the net in the mild solvent if 
required. 

4. Replace the net filter and the screw-top. 
Screw on tight! 

 
 
 
 

CONTACT INFORMATION 
 
PhyTech Ltd. 
Yad Mordechai, 79145, Israel 
Tel.: 972-8-6736804 
Fax: 972-8-6736820 
E-mail: info@phytech.co.il 
URL: www.phytech.com  
 


